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Introduction

Welcome!

LABELVIEW 8 label design and integration software provides
an easy-to-use, user-friendly solution for printing bar code
labels and tags to meet compliance standards in any industry. 

What’s New? New features in version 8 include:

• Updated Interface - New look and new toolbar buttons

• RFID label printing - Encode radio frequency tags

• New Bar Codes - UCC/EAN Composites & UCC/EAN-128 
Coupon Extended Codes

• Rich Text Fields - Advanced text formatting features

• TextArt - Allows text to be “bent” at precise angles to fit 
a selected shape type (ellipse, polygon, rectangle, etc.) 
and formatted using custom spacing, borders, and back-
grounds

• AutoSize Text - Printer resident fonts are automatically 
sized to fill a pre-sized field

• TrueType Font Flexibility - Independently change the 
width and height of TrueType fonts

• SQL Query Builder - Wizard for creating an SQL state-
ment

For a complete listing of all new features, printer drivers and
corrections in LABELVIEW 8, see the program’s Readme.txt
file.

e
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LABELVIEW 
Editions

LABELVIEW label design software is available in three editions
— Basic, Pro, and Gold. (The edition and release number for
your software are printed on a label located on the LABELVIEW
box, as well as on the hardware key for Hardware Key
versions.) The following table provides an overview of the
main features included in each edition.

FEATURE Basic Pro Gold 
General
Print-only version  • • 
Network version   • 
Printer code converter   • 
Label samples • • • 
Unlimited number of fields per label (25) • •
Hidden (unprintable) objects • • • 
Graphic formats import (bmp, pcx, jpg, tif, etc.) • • • 
Color support • • • 
Color graphic reduction • • • 
Graphical bar codes • • • 
Native bar codes • • • 
Multi-level password protection  • • 
Label specific passwords  • • 
Label previews • • • 
Multilingual support • • • 
Custom bar code support • • • 
2D bar code support  • • 
HIBC support  • • 
Print to file • • 
Print to picture • • 
TextArt • •
RichTextField objects • •
Database
Database Editor (DBF and ODBC data source)  • • 
OLE DB and ODBC support  • • 
Key field access to database records  • • 
Table view/print  • • 
DSN file support  • • 
Customized SQL queries   • 
Variables
Flexible date and time stamping • • • 
Variable graphic images  • • 
Shared serial files  • • 
Linked expressions  • • 
Incrementing fields • • 
Add an offset to date • • • 
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Other LABELVIEW Configurations

LABELVIEW Full 
Design and Run-
Time Versions

LABELVIEW is available in a Full Design version and in a Run-
Time (print only) version. The Full Design version is required
in order to design, edit and save label design files. The Run-
Time version must be used in conjunction with a Full Design
version. Run-Time is limited to only opening and printing
labels; you cannot add, move, delete or edit fields on a label.

LABELVIEW Single 
and Network 
Versions

A LABELVIEW Single-User version is a stand-alone program
that is intended to be installed on one PC. The LABELVIEW
Network version is a multi-user license available only with the
Gold edition. For more information on the Network version of
LABELVIEW, see Chapter 4, "Network Licensing Setup".

User Input Fields
Set input format • • • 
Minimum input length • • 
Pick List data entry • • • 
Tools
Directly modify printer code with Job Modifier utility • • 
LABELVIEW Symbol (industry specific symbols) • • • 
User-definable reports generated from label log 
files • 

Automatically e-mail reports to track label stock 
usage (Media Tracking)  • 

Pocket LABELVIEW support • •
Pocket LABELVIEW licenses (0) (1)
Automatic printing from a source database 
(DataWatch) • 

Print labels from serial device data (CommWatch) • 
Automatic printing based on a key field entered by 
an operator (Label Select) • 

Print labels automatically using simple instruction 
files (Command Files) • 

Visual Basic form builder • 
RFID tag support •
Programmability
OLE Client (insert WordArt, spreadsheets, etc.) • • 
OLE Automation  • 
DDE (Dynamic Data Exchange) •

FEATURE Basic Pro Gold 
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Software Protection Methods

The method of software protection used depends on the type
of LABELVIEW package you purchased (protection provided
through either a Hardware Key [a dongle] or a Software Key
[an electronic code]).

Software Key 
Protection

LABELVIEW 8.01 introduces a new method of software
protection and activation which replaces the conventional
Hardware Key method that was previously required to run the
software. The Software Key method requires simply that you
enter an electronic code to activate the software, so you no
longer have to worry about hardware key connection problems
or key failure issues. The Software Key license is sometimes
called a “keyless” license because it does not require an actual
key to be connected to the PC.

For more information, see Chapter 2, "Installing LABELVIEW
with a Software Key".

Hardware Key 
Protection

If you have purchased a Hardware Key package, your software
will include a hardware key device, also called a HASP
(Hardware Against Software Piracy) key or dongle, that must
be installed on the computer to run the software. The
hardware key holds an encrypted code which is deciphered by
the LABELVIEW software to determine settings such as
licensing, release version, full design or print only version, and
the edition information of the software that has been
purchased.

For more information, see Chapter 3, "Installing LABELVIEW
with a Hardware Key".
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System Requirements
• IBM-compatible PC, 486 or better

• Microsoft Windows 98 SE, Windows Me, Windows NT 4.0, 
Windows 2000, Windows XP or Windows Server 2003

• 32 MB RAM with Windows 98 or Windows Me (64 MB rec-
ommended)

• 64 MB RAM with Windows NT 4.0 or Windows 2000 (128 
MB recommended)

• 128 MB RAM with Windows XP (256 MB recommended)

• 256 MB RAM with Windows Server 2003 (512 MB recom-
mended)

• Hard drive with at least 50 MB free disk space

• Parallel port if using a parallel key (hardware key)

• USB port if using a USB key (hardware key)

• Serial port if required by printer

• VGA monitor or better

• CD-ROM drive

• Mouse

Product Components 

Your label design software is packaged with the following
components:

• CD-ROM

• Documentation appropriate for the version you purchased

• Hardware key (if you purchased a Hardware Key version)

The edition and release number for your software 
are printed on a label placed on this guide and 
also on the LABELVIEW box.
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Viewing the Readme File

The Readme.txt file that installs with the software contains
information about the most recent changes and updates to the
label design software that were made after this manual was
printed. This information supersedes what is contained in this
manual.

Registering Your Software

Registering your software not only provides you with free
Technical Support options, but it also ensures you are notified
of critical updates and patches as they are released. 

X To register your software (after the program is 
installed):

1 In LABELVIEW, click on the Help menu and then click 
Register your product.

2 Select the desired method of registration and follow the 
instructions displayed on the screen.
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Software Key

Before Installing
• If you have already downloaded and installed the current 

LABELVIEW Demo, there is no need to install again from 
the CD. For Software Key versions, proceed to the "Acti-
vating the Software Key" section on page 2-5 for instruc-
tions on activating the software and converting it from a 
trial version to a full product.

• Disable all anti-virus software.

• Close all other applications that are currently running.

Software Key Installations

Software Key:
Full Install

X To perform a full install for a Software Key version:

1 Insert the CD. 

The CD’s opening screen will appear. If the CD does not 
automatically open, on the taskbar, click the Start button, 
and then click Run. Type the letter of the CD-ROM drive 
followed by CDSetup.exe (e.g., D:\CDSetup.exe).

Local administrative privileges are required for 
proper installation. Contact your system adminis-
trator for assistance.

e
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Figure 2-1 LABELVIEW CD Opening Screen

2 On the opening screen of the CD, click on LABELVIEW 
8.01, and then click the Install button. 

3 Select the desired language for the software interface 
screens, and then click OK.

The Preparing to Install screen will appear, followed by 
the welcome screen for the installation wizard.

4 Follow the on-screen instructions through the wizard until 
you reach the Custom Setup screen.
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Figure 2-2 Custom Setup

5 On the Custom Setup screen, you can click on a program 
feature in the list to view the amount of hard drive space 
required to install the feature.

By default, all listed features (graphic files, database files, 

conversion utilities, sample files, etc.) will be installed. To 

deselect a feature, click its  icon and then click 

This feature will not be available.

Note Click the Help button on this screen to view the different install 
state icons and their meanings.

6 Below the feature list window, the Install to line shows 
the default installation folder (C:\Program Files\LV8\).

It is recommended that you leave the installation location 
at its default setting. If it is necessary to install to a differ-
ent location, click the Change button and specify the new 
location.
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7 Click Next.

The installation wizard installs the LABELVIEW software. 

This may take several minutes.

When the wizard has completed the install, a message 
appears to inform you that LABELVIEW 8.01 has been 
installed successfully.

8 Click Finish to exit the wizard.

Software Key: 
Version Upgrade

If you are upgrading from a previous Hardware Key package
to a Software Key package, your product box will contain a Key
Migration Kit. This kit contains all of the necessary instructions
and software needed to transfer your current Hardware Key-
based software protection license to a Software Key license
(sometimes called a “keyless” license because it does not
require an actual key to be connected to the PC). 

To upgrade your software and migrate your license from
Hardware Key to Software Key, use the Key Migration Tool
CD contained in the kit, and follow the steps in the instruction
booklet provided.

Software Key: 
Edition Upgrade or 
Adding Users

If you are performing an Edition Upgrade (e.g., from
LABELVIEW 8.01 Pro edition to LABELVIEW 8.01 Gold edition)
or if you are adding users, you do NOT need to reinstall the
software.

X To perform an Edition Upgrade or add users for a 
Software Key version:

• If you have purchased an Edition Upgrade or Add-on 
licenses for a Software Key version, your product box will 
contain a “TEKLYNX Softkey Upgrade Program” document 
that includes a printed label with your product serial 
number. To perform the upgrade, follow the detailed 
instructions included in this document. 

If you are upgrading from a previous Hardware 
Key package to a Software Key package, you 
must first install the LABELVIEW software, then 
migrate your license using the Key Migration Kit, 
and finally, activate the software.
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Activating the Software Key

Once you have installed LABELVIEW, the Activation Wizard will
take you through the process of activating the software.

X To activate the Software Key:

1 Start LABELVIEW.

A welcome screen appears displaying options to activate 
the software immediately or to try it for an evaluation 
period.

Figure 2-3 Activation Wizard

2 Click Activate, and then click Next.

The Select Activation Mode screen appears.
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Figure 2-4 Select Activation Mode

3 Select from three options for the activation method 
(Automatic (Internet), Fax/e-mail, or Telephone), 
and then click Next.

4 Depending on the activation method selected, follow the 
appropriate steps below to complete the activation pro-
cess.

Note Once the software has been activated, the Activation Wizard 
will no longer appear upon startup, and you will be able to use 
the software with all features and functionality enabled.
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Automatic (Internet) Activation Method

1 Fill in all required fields on the User Registration screen, 
and then click OK.

2 On the Internet Activation screen, enter the Activation 
Code you received with the product, and then click Next. 

A message will appear to inform you that activation was 
successful. If any problems are encountered, a message 
will inform you that activation has failed.

3 Click Finish to complete the activation process.

Fax/e-mail Activation Method

1 Fill in all required fields on the User Registration screen, 
and then click OK.

2 On the Activation Code screen, enter the Activation Code 
you received with the product, and then click Next. 

3 Click the Create Form button.

An Activation Request Form will be created with all of the 
required user information. This form must be sent via fax 
or e-mail in order to receive a Response Code. For sending 
instructions, please refer to the contact information given 
on the screen.

4 Click Next.

While waiting for a Response Code, you may choose to 
launch your software and begin using it, or close it and 
return to the activation process once you have received 
your Response Code. (Note: Once you return to the wiz-
ard, all options you previously selected in the wizard will 
be retained.)

5 Once you have received your Response Code, you can 
return to the activation process by restarting the wizard 
and then clicking Next until you reach the screen that 
includes the option to Enter the Response Code. 
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6 Enter the Response Code provided to you, and then click 
Next.

A message will appear to inform you that activation was 
successful. If any problems are encountered, a message 
will inform you that activation has failed.

7 Click Finish to complete the activation process.

Telephone Activation Method

1 On the Phone Activation screen, enter the Activation 
Code you received with the product, and then click Next. 

2 Call the appropriate phone number for your area (pro-
vided on the screen).

You will be required to give all user registration informa-
tion over the phone, so please have your company infor-
mation at hand before calling.

3 Enter the Response Code provided to you, and then click 
Next.

A message will appear to inform you that activation was 
successful. If any problems are encountered, a message 
will inform you that activation has failed.

4 Click Finish to complete the activation process.
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Hardware Key

Before Installing
• If you have already downloaded and installed the current 

LABELVIEW Demo, there is no need to install again from 
the CD. To convert your installed demo version to a full 
product, close LABELVIEW, place the hardware key on the 
computer, and then restart the program. 

• Disable all anti-virus software.

• Close all other applications that are currently running.

• Select one computer to designate as the “key server.” You 
will need to install the label design software on this com-
puter and then AFTER installation, attach the hardware 
key to the computer. (The hardware key should never be 
attached to the computer before or during the installation 
of the software. For more information on proper use of the 
hardware key, see the "Attaching the Hardware Key" sec-
tion on page 3-5.) 

Local administrative privileges are required for 
proper installation. Contact your system adminis-
trator for assistance.

e
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Hardware Key Installations

Hardware Key:
Full Install

X To perform a full install for a Hardware Key version:

1 Insert the CD. 

The CD’s opening screen will appear. If the CD does not 
automatically open, on the taskbar, click the Start button, 
and then click Run. Type the letter of the CD-ROM drive 
followed by CDSetup.exe (e.g., D:\CDSetup.exe).

Figure 3-1 LABELVIEW CD Opening Screen

2 On the opening screen of the CD, click on LABELVIEW 
8.01, and then click the Install button. 

3 Select the desired language for the software interface 
screens, and then click OK.

The Preparing to Install screen will appear, followed by 
the welcome screen for the installation wizard.

4 Follow the on-screen instructions through the wizard until 
you reach the Custom Setup screen.
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Figure 3-2 Custom Setup

5 On the Custom Setup screen, you can click on a program 
feature in the list to view the amount of hard drive space 
required to install the feature.

By default, all listed features (graphic files, database files, 

conversion utilities, sample files, etc.) will be installed. To 

deselect a feature, click its  icon and then click 

This feature will not be available.

Note Click the Help button on this screen to view the different install 
state icons and their meanings.

6 Below the feature list window, the Install to line shows 
the default installation folder (C:\Program Files\LV8\).

It is recommended that you leave the installation location 
at its default setting. If it is necessary to install to a differ-
ent location, click the Change button and specify the new 
location.
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7 Click Next.

The installation wizard installs the LABELVIEW software. 

This may take several minutes.

When the wizard has completed the install, a message 
appears to inform you that LABELVIEW 8.01 has been 
installed successfully.

8 Click Finish to exit the wizard.

9 When installation is complete, attach the hardware key as 
directed in the "Attaching the Hardware Key" section on 
page 3-5.

Hardware Key: 
Version Upgrade

If you are upgrading from LABELVIEW version 6.0 or above (a 
Hardware Key to Hardware Key upgrade) and the earlier 
version is currently installed on the computer, you should 
install the new version over the earlier version. Any 
configuration settings you previously set up in the earlier 
version will be saved.

X To perform a Version Upgrade for a Hardware Key 
version:

1 Follow the steps in the "Hardware Key: Full Install" section 
on page 3-2 to install the software.

2 Upgrade your hardware key as instructed in the "Key 
Upgrade Procedure" section on page 3-6.

If you are upgrading to a Software Key version of 
LABELVIEW (a Hardware Key to Software Key 
upgrade), you must first migrate your license 
using the Key Migration Kit. For more informa-
tion, see Chapter 2, "Installing LABELVIEW with a 
Software Key".
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Hardware Key: 
Edition Upgrade or 
Adding Users

If you are performing an Edition Upgrade (e.g., from
LABELVIEW 8.01 Pro edition to LABELVIEW 8.01 Gold edition)
or if you are adding users, you do NOT need to reinstall the
software.

X To perform an Edition Upgrade or add users for a 
Hardware Key version:

• Upgrade your hardware key as instructed in the "Key 
Upgrade Procedure" section on page 3-6.

Attaching the Hardware Key

The Hardware Key version of the software includes a hardware
key device, also called a HASP (Hardware Against Software
Piracy) key or dongle, that must be installed on a computer to
run the software. The hardware key holds an encrypted code
which is deciphered by the LABELVIEW software to determine
settings such as licensing, release version, full design or print
only version, and the edition information of the software that
has been purchased.

Note The hardware key is not related to the location or number of 
printers. LABELVIEW is licensed for concurrent users and not 
per seat.

The hardware key is easy to use — simply connect it to the
appropriate port (parallel port or USB port, depending on the
type of key you purchased) before launching the software. 

If attaching a parallel key and a printer will be attached to the
same port, connect the printer cable to the parallel key. (The
printer may need to be powered on before the key is
recognized.)

If attaching a USB key, note that when connected properly it
should light up to indicate that it has been recognized by the
operating system.

Without the hardware key, the program will run 
in Demo Mode and will place a demo message on 
all labels printed with the software.
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Figure 3-3 Connecting the hardware key to the parallel port

Figure 3-4 Connecting the hardware key to the USB port

Key Upgrade Procedure

In order to perform a Hardware Key to Hardware Key version
upgrade, you must first upgrade the hardware key using the
following steps.

Note The Key Upgrade procedure works only with HASP keys.

1 On the computer with the key attached, in the LABELVIEW 
software, on the Help menu, click System Status, and 
then click the Upgrade Version button.

The Key Upgrade dialog box appears, displaying your 24-
digit Key Code.

2 Send an e-mail to customerservice@teklynx.com with the 
word UPGRADE in the subject line and include the follow-
ing two pieces of information in the body of the e-mail:
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• Authorization Code (obtained from the Key Upgrade 
Program sheet included in your product box)

• Key Code (displayed on the Key Upgrade dialog box)

You will receive a return e-mail from TEKLYNX Customer 
Service with your new Upgrade Code.

3 Enter the new Upgrade Code in the box provided (on the 
Key Upgrade dialog box accessed in Step 1) and click 
Upgrade.

The message “Upgrade was done successfully” appears 
when your key upgrade is complete.

4 Label your key with the provided key label (opposite side 
of serial number) and follow the steps in the "Registering 
Your Software" section on page 1-6 to register your new 
product version.

If you have any problems with the Key Upgrade procedure,
please contact TEKLYNX Customer Service at 888-629-4444 or
e-mail customerservice@teklynx.com.
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Network Licensing Setup

License Management

The license management utilities, included with the network
(multi-user) packages, allow you to control access to the label
design software licenses across the network. Using one of
these utilities, you can have many users accessing the label
design software at the same time, from anywhere on the
network. When users are logged onto the program, their user
names will appear in the users list so administrators can keep
track of who is using the program.

Depending on your system setup, you may choose to install
one of the following license management utilities:

• The License Manager utility (LVLicenseManager.exe) is 
the standard licensing program that must be started man-
ually each time your system is powered on. License Man-
ager must be running in order for users on the network to 
have full access to the label design software. If this pro-
gram is not active, then all users will operate in Demo 
Mode. 

• The License Service utility (SLicenseCtrl.exe) is similar 
to License Manager, but runs as a service, which means it 
launches automatically when the system is powered on 
and will run as a background task as long as the worksta-
tion is on. Note that this service runs only on Windows NT, 
2000, XP and Windows Server 2003 systems (Software 
Key software protection method recommended for Win-
dows NT).

e
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X To install the license management utility:

1 Please note the following BEFORE installing License 
Manager or License Service:

• In most cases, it is recommended that you install the 
LABELVIEW software first, followed by the installation 
of the license management utility.

• The license management utility need only be installed 
one time in one central location (either on a central 
server or other shared server with all users mapped to 
it).

• Implementation and setup of the license management 
utilities require full administrative privileges on the 
license server, and cannot be set up remotely (i.e. 
cannot be set up using Remote Desktop).

• The installation folder of the license management util-
ity (by default, C:\Program Files\LV8) must be a 
shared and mapped letter drive, allowing other 
workstations full control, read/write, and modify 
rights. Without full control access, the user will stay 
logged into the licensing utility even after closing the 
label design software.

• The license management utilities are not compatible 
with Novell systems, so Novell network users must 
designate a Windows workstation to be the license 
server.

2 Insert the CD on the computer chosen to act as the license 
server.

The CD’s opening screen will appear. If the CD does not 
automatically open, on the taskbar, click the Start button, 
and then click Run. Type the letter of the CD-ROM drive 
followed by CDSetup.exe (e.g., D:\CDSetup.exe).

3 On the opening screen of the LABELVIEW CD, select Net-
work Manager, and then click Install.

The install program begins preparations for the Label 
Design Network Utilities setup process (this may take a 
moment).
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4 On the Protection type screen, select the appropriate 
protection type based on the product you purchased 
(either a Software Key or Hardware Key version), and 

then click Next.

Figure 4-1 Protection Type

5 On the wizard’s Welcome screen, click Next to continue 
with the installation of the network licensing utilities.

6 Now on the Setup Type screen, choose the setup type 
that best suits your needs:

• Select the Complete install option if you want both 
license management utilities (License Manager and 
License Service) to be installed. 

• Select the Custom install option if you want to specify 
to install either the License Manager or License Service 
utility, or specify to install both utilities.

7 Click Next.
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8 If you selected the Custom install option, select the 
license management utility (or utilities) to install — either 
License Manager and/or Service Installation (License 

Service) — and then click Next.

Figure 4-2 Custom Setup

9 On the Ready to Install screen, click Install to being 
installing the Label Designer Network Utilities.

10 When the installation is complete, click Finish to exit the 
install wizard.
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Setting Up a Network Version

Follow the guidelines below when setting up a network (multi-
user) version of the label design software:

• Each workstation requires a mapped letter drive in order 
to properly access the license management utility on the 
license server. The root directory of the software (i.e. 
C:\Program Files\LV8) must be shared and mapped allow-
ing other workstations full control, read/write, and modify 
rights to all potential users.

• For Hardware Key packages, the hardware key must be 
attached to the server AFTER the software has been 
installed successfully. Only one hardware key is included 
with a network version of the software, pre-programmed 
with the number of licenses purchased. (For more infor-
mation on proper use of the hardware key, see the 
"Attaching the Hardware Key" section on page 3-5.)

Network/Multi-
User: Setup for a 
Full Install

1 Install the LABELVIEW software according to the instruc-
tions in either Chapter 2, "Installing LABELVIEW with a 
Software Key" or Chapter 3, "Installing LABELVIEW with a 
Hardware Key" depending on the type of product you pur-
chased.

2 Install the license management utility (either License 
Manager or License Service) according to the "License 
Management" section on page 4-1.

3 For Hardware Key versions, attach the hardware key as 
directed in the "Attaching the Hardware Key" section on 
page 3-5.

4 Start the LABELVIEW software. (You may see errors upon 
opening, before the network configuration has been per-
formed).

5 Install and select your printer. (For information on printer 
setup, see Chapter 5, "Printer Setup").



Chapter 4-6 Installation Guide

6 In LABELVIEW, select Configuration from the Options 
menu, and then click on the Network tab. Check the Net-

work Key box, and use the  button or Auto Find... 

button to browse to the mapped letter drive location of the 
program’s LICENSE directory.

7 Close LABELVIEW.

8 On the license server, run the license management utility 
you installed — either License Manager 
(LVLicenseManager.exe) or License Service 
(SLicenseCtrl.exe) — found in the LABELVIEW 8 program 
group. 

9 Start the LABELVIEW software again. If the license server 
install was configured properly, LABELVIEW will open with-
out error, and License Manager or License Service should 
reflect one user accessing the program. If unsuccessful, 
refer to Appendix A, "Troubleshooting Installation Issues" 
before continuing.

10 Install the LABELVIEW software on each workstation 
where the label design software will be used (do NOT 
install the license management utility on the worksta-
tions). Through Windows, map to the license server (the 
network drive where the license management utility is 
installed).  

11 For each installation repeat Step 6. Only this time, browse 
to the program’s LICENSE directory on the mapped letter 
drive from Step 10.

12 Shut down and restart the label design software to com-
plete the network installation.

Each workstation requires a mapped letter 
drive in order to properly access the license 
management utility on the license server. Refer to 
your Windows documentation or ask your system 
administrator for the necessary instructions.
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Network/Multi-
User: Setup for a 
Full Install for 
Terminal/Citrix 
Server and Remote 
Desktop

1 Install the LABELVIEW software according to the instruc-
tions in either Chapter 2, "Installing LABELVIEW with a 
Software Key" or Chapter 3, "Installing LABELVIEW with a 
Hardware Key" depending on the type of product you pur-
chased.

2 Install the license management utility (either License 
Manager or License Service) according to the "License 
Management" section on page 4-1.

3 For Hardware Key versions, attach the hardware key as 
directed in the "Attaching the Hardware Key" section on 
page 3-5.

4 Start the LABELVIEW software. (You may see errors upon 
opening, before the network configuration has been per-
formed).

5 Install and select your printer. (For information on printer 
setup, see Chapter 5, "Printer Setup").

6 In LABELVIEW, select Configuration from the Options 
menu, and then click on the Network tab. Check the Net-

work Key box, and use the  button or Auto Find... 

button to browse to the mapped letter drive location of the 
program’s LICENSE directory.

7 Close LABELVIEW.

8 On the license server, run the license management utility 
you installed — either License Manager 
(LVLicenseManager.exe) or License Service 

(SLicenseCtrl.exe) — found in the LABELVIEW 8 program 
group. 

For Terminal Server/Citrix Server and Remote 
Desktop installations, the LABELVIEW software 
must be installed on a server along with the 
License Manager or License Service utility.
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9 Start the LABELVIEW software again. If the license server 
install was configured properly, LABELVIEW will open with-
out error, and License Manager or License Service should 

reflect one user accessing the program. If unsuccessful, 
refer to Appendix A, "Troubleshooting Installation Issues" 
before continuing.

10 Set up all LABELVIEW configuration options as follows: 

• On the Options menu, click Configuration. Use the 
tabs on the Configuration dialog box to set up all 
LABELVIEW configuration settings that you want to be 
available for all users (i.e., network licensing, printing 
options, display language, etc.).

• On the Options menu, click Directories. Use the 
Directories dialog box settings to specify the direc-
tory path for each data source option you want to be 
available for all users.

• Configure any other Options menu settings (serial 
files, accumulator files, label inventory, etc.) that you 
want to be available for all users.

11 After all configuration options are set, close LABELVIEW to 
update the label.ini configuration file with the new set-
tings.

12 Set up all remote terminals.

Now you can log onto the server or any remote terminal 
and the configuration file will be copied to each user as the 
user logs into the workstation or server and executes the 
LV.exe program file.

With Terminal Server/Citrix Server installations, 
each terminal will have its own unique 
LABELVIEW configuration file. For this reason, 
you MUST set all configuration options before 
setting up each remote terminal. Note that if 
system security is desired, this will also need to 
be set up BEFORE setting up the remote 
terminals. For information on setting up system 
security, see Chapter 6, "Setting Up System 
Security".
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Using License Manager 
1 On the Windows taskbar, go to Start > All Programs > 

Teklynx > License Manager.

The License Manager dialog box appears displaying a list 
of users, if any, who are currently using the label design 
software.

Figure 4-3 License Manager

2 Use the following buttons to update and display informa-
tion in License Manager:

 Closes License Manager.

 Updates the display to show the users currently 

logged into the label design software. (The display is auto-
matically updated every few seconds.) Note: If the display 
is not refreshing correctly to reflect the actual user status, 
verify that the users who are logging out have the 

required permissions (modify rights) needed to delete 
their user listings as they log out.

 Displays License Manager version information.

3 Click  to exit License Manager.
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Using License Service

Note License Service runs only on Windows NT, 2000, XP and 
Windows Server 2003 systems. (Software Key software 
protection method recommended for Windows NT.)

1 On the Windows taskbar, go to Start > All Programs > 
Teklynx > License Service.

The License Service dialog box appears displaying a list 
of users, if any, who are currently using the label design 
software.

Figure 4-4 License Service

2 Click Start  to start License Service. Once it is started, 

from then on the service will launch automatically when 
the system is powered on and will run as a background 
task as long as the workstation is on.
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3 Use the following buttons to update the users list, config-
ure settings, and display information in License Service:

 Updates the display to show the users currently 

logged in to the label design software. (The display is 
automatically updated every few seconds.) Note: If the 
display is not refreshing correctly to reflect the actual user 
status, verify that the users who are logging out have the 
required permissions (modify rights) needed to delete 
their user listings as they log out.

 Allows you to configure License Service settings 

including: specifying the license file path, setting the 
option to stop the service when users are connected, and 
selecting a display language.

 Displays License Service version information.

4 Click  to exit License Service.

Note
 

Exiting the License Service dialog box does NOT stop the 
service; it will continue to run as a background task. (To stop 
the service, click Stop  on the License Service dialog 
box.)
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Printer Setup

LABELVIEW supports over 1,000 specialized thermal and
thermal-transfer label printers and any printer with a valid
Windows driver supplied by the manufacturer. Printer drivers
included with this label design software are installed to the
program’s Drivers directory when the program is installed.

For optimum results when designing and printing labels in this
label design software, use one of the high speed printer drivers
installed with the program.

Selecting a 
LABELVIEW Driver 
for Printing Labels

1 On the File menu, click Select Printer, and then click 
Install.

The Install Printer Drivers dialog box appears.

For thermal and thermal-transfer printers, use 
only the drivers that are installed with LABEL-
VIEW. If you use a driver that was installed 
through Windows, you may experience slow 
printing or encounter errors at print time.

e
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Figure 5-1 Install Printer Drivers

The printers appearing in the Printer Model list depend 
on the check box settings below it. 

2 Check to make sure that both the Native drivers-(V) 
and Extended drivers-(X) check boxes are selected in 
order to view all available drivers.

Some printers include both a native driver and an 
extended driver for the same printer model, designated in 
the program as follows:

(V) = Driver is a native software driver (developed specif-
ically for use with this label design software)

(X) = Driver is from an extended driver set

If an extended (X) driver is selected, you can 
access the printer driver’s advanced properties, 
allowing you to take advantage of the most pow-
erful capabilities of the printer. To access these 
properties, go to Edit menu > Label Setup > 
Options tab > Settings button (an extended (X) 
driver must be selected in order for the Settings 
button to appear).
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3 Using the Available Printer Drivers lists, select your 
printer’s manufacturer and model.

4 With the desired printer selected, click Install. 

The printer driver appears highlighted in the Installed 
Printers list.

5 By default, new printers are assigned to the local LPT1 
port. If your printer is not connected to LPT1, click 
Connect and select the correct port. Adjust the settings, 
if necessary, according to your printer documentation.

If the printer is connected to a serial port, click the 
Setting button to configure the driver to match the 
printer device settings (baud rate, data bits, stop bits, 
parity, flow control). The printer and the computer MUST 
be set to exactly the same values. Check your printer 
documentation for the correct settings.

Note To function properly, many serial printers need to be physically 
connected with a null modem cable or null modem adapter on 
a standard RS232 cable.

6 Click OK, Close, and OK to return to the design window.

The selected printer appears in the Status bar. Printer 
device settings—such as print speed, paper feed mode, 
and cutter options— are defined during label setup on the 
Edit menu > Label Setup > Options tab. 

If your label was designed for a different printer, 
a message will appear asking if you want to mod-
ify the label. Click Yes to convert the label to 
work with the currently selected printer. The 
changes made for the conversion will not be per-
manent until you save the label. You may need to 
do some fine-tuning if the label conversion is not 
exact, so be sure to print a test label before you 
commit to a large print run.
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Setting Up System Security

The system security feature (available only in Pro and 
Gold editions) allows you to restrict users to certain fea-
tures of the program. You can set up system security by 
assigning a user ID and password and then selecting the 
tasks the user may perform. When you restart the pro-
gram after setting up a user, the security feature is 
enabled, and all users will be required to log in before 
using the program. 

New in LABELVIEW 8, the program assigns EACH 
USER with his or her own unique configuration 
file instead of using one configuration file for all 
users. For this reason, before adding system 
users and assigning access rights, you must first 
specify the LABELVIEW configuration settings you 
want to be available to ALL USERS. These set-
tings will be saved in the initial configuration file 
(named label.ini), which will be copied to each 
user to generate their unique configuration file. 
After the label.ini file is copied to a user it is then 
renamed using the following naming convention: 
PCName_UserName.ini.

e
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X To set up system security:

1 On the license server, start the LABELVIEW software.

2 Set up all LABELVIEW configuration options as follows: 

• On the Options menu, click Configuration. Use the 
tabs on the Configuration dialog box to set up all 
LABELVIEW configuration settings that you want to be 
available for all users (i.e., network licensing, printing 
options, display language, etc.).

• On the Options menu, click Directories. Use the 
Directories dialog box settings to specify the direc-
tory paths of the files you want to be available for all 
users.

• Configure any other Options menu settings (serial 
files, accumulator files, label inventory, etc.) that you 
want to be available for all users.

3 After all configuration options are set, close LABELVIEW to 
update the label.ini configuration file with the new set-
tings.

4 Restart LABELVIEW.

5 On the Options menu, click Security.

6 Click New. 

The Edit User Information dialog box appears.
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Figure 6-1 Edit User Information

7 Enter a User ID in the User ID box. 

For example, for the administrator the User ID might be 
“Admin.”

8 Enter a password in the Password box. 

Note The User ID and Password are each limited to 10 characters. 

9 Set up access privileges for this user by selecting the 
appropriate check boxes. 

For example, for the administrator you would want to 
select all the check boxes to allow access to the entire 
system and all system tasks. 

10 Click OK. 

If you intend to set up system security, you must 
first designate a user who will have access to the 
entire system. Without this “administrator” 
access, you can become inadvertently locked out 
from all or portions of the program. 
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The System Security dialog box appears displaying the 
new user. 

11 Repeat Step 6 through Step 10 above to add each user.

12 Click Exit to return to the design window. 

13 Close LABELVIEW.

14 Restart the LABELVIEW software. When you restart the 
program, you will be prompted for a password.

15 Log on to LABELVIEW as each user, which will generate 
the user’s unique configuration file and ensure that the 
configuration options set in Step 2 are transferred to each 
user’s .ini file at this time.



Troubleshooting

A

Installation Issues

The following table lists the most common error messages, issues, and questions
encountered when installing the LABELVIEW software. 

For the most current information on installation issues and troubleshooting tips,
please reference the “LABELVIEW Top 10 FAQs” page on the TEKLYNX web site at
http://www.teklynx.com/products//labels/faq/labelview_faq_1243.html.
This page is also available directly from within the LABELVIEW software by going to
Help menu > Teklynx Online > Top 10 FAQs.

Problem/Question Solution

Software Key Issues

I’m trying to install the soft-
ware but it’s asking me for a 
code in order to “activate” it? 
Where do I get this code? 

If you are installing a full Software Key ver-
sion of the software, an Activation Code will 
be provided in your product box.

If you are upgrading from a previous Hard-
ware Key version to a new Software Key 
version, your product box will contain a Key 
Migration Kit. Follow the instructions con-
tained in this kit to “migrate” your key. At 
the end of the process you will receive an 
Activation Code that will allow you to acti-
vate the software. 

e
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What happens if I lose my 
Activation Code?

Please contact TEKLYNX Customer Service 
at 888-629-4444 or e-mail 
customerservice@teklynx.com. You will 
need to provide them with the serial num-
ber on your invoice or from the product box. 
They can then re-issue an Activation Code.

I went through the Key 
Migration process to migrate 
my key, but I didn’t write 
down the Activation Code 
given at the end. Now what 
do I do? 

I installed the software as a 
trial version at first, and then 
a few days later I activated it 
using the code provided in 
my product box. The problem 
is, after I activated it, sev-
eral of the features I was 
using in the trial version 
were suddenly not available. 
Why is this?

If an option appears “grayed out” and is not 
available for selection in the activated soft-
ware, this is most likely because that fea-
ture is not included in the edition you 
purchased. When you run the trial version, 
it automatically defaults to running the Gold 
(high-end) edition of the software. When 
you activate it, it runs the edition you actu-
ally purchased (probably Pro or Basic).

A complete list of features included in each 
edition can be found in the "LABELVIEW 
Editions" section on page 1-2 of this guide.

What if the PC crashes or I 
need to transfer the license 
to another PC? 

You must contact Customer Service and 
provide them with your Activation Code. 
Another authorization code will be given to 
reactivate the product.

What if the PC crashes in the 
middle of the night, over the 
weekend, or on a holiday - 
how can I reactivate the 
product with no down time?

By installing the CD on another PC, you 
start with a grace period during which you 
run the software as a trial version. All prod-
uct features will be available during that 
period, which gives you time to continue 
using the software with no down time, until 
you can contact us to reactivate your prod-
uct.

What happens if I uninstall 
the software by accident and 
need to re-install it on the 
same PC later?

As long as you have not formatted your 
hard disk, your product will run without 
requiring a new Activation Code. 

(Table continued from previous page)

Problem/Question Solution
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I lost the CD and I need to 
re-install the software. What 
do I do?

For Software Key versions, if you lost the 
CD and need to re-install, you can download 
the re-installation files from the TEKLYNX 
web site at http://www.teklynx.com/prod-
ucts//labels/labelview_downloads.html. As 
long as you are installing to the same PC 
and have not formatted your hard disk, this 
is all that is needed to re-install the soft-
ware.

I installed a Software Key 
demo version that I down-
loaded from the web site. 
Can I turn this into a full 
license without having to re-
install the product? 

Yes. When you purchase a product you will 
receive an Activation Code. You can use this 
Activation Code to activate the trial version 
without having to re-install.

Hardware Key Issues

Error: Could not find the Key In some instances, the driver reading the 
hardware key is not updated properly. To 
upgrade your hardware key’s HASP driver, 
go to http://www.teklynx.com/
support//faq/faq_193.html and download 
the HASP Upgrade Wizard. Follow the 
instructions to upgrade the driver.

For step-by-step instructions on resolving 
Demo Mode issues, view the “LABELVIEW in 
Demo Mode” eHelp video at 
http://www.teklynx.com/products//labels/
labelview_faq_videos.html.

Message: This 30 day Evalua-
tion...

Program running in Demo 
Mode

Error: This Key is not a Net-
work Key 

Within the hardware key is an encrypted 
code. This code contains the licensing, 
release, full design or print only, number of 
users, and edition information of the soft-
ware that has been purchased. This infor-
mation is printed on both the label on the 
hardware key and the label on the back of 
this guide.

(Table continued from previous page)

Problem/Question Solution
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Error 5032: No more licenses 
available on this Network 
Key right now

Please verify that you have purchased and 
installed a network (multi-user) version of 
LABELVIEW. (The number of users is printed 
on the hardware key.) 

If you do have a network version, open the 
license management utility (License Man-
ager or License Service) on the license 
server. If the license utility is showing the 
correct number of users but you see the 
error: “LABELVIEW is unable to write to the 
C:\Program Files\LV8\System\License 
directory due to permission or security 
restrictions,” ensure that all users have full 
read\write\modify rights to this directory. 
All users MUST have full read\write\modify 
rights to this directory in order to allocate a 
license.

If the license utility is showing an incorrect 
number of users, please contact your 
reseller.

Error 5001 nn: Server not 
found

The network installation has not been com-
pleted on the license server. Launch the 
license utility (License Manager or License 
Service) and verify that the number of 
users matches the number of users printed 
on the hardware key label. On the license 
server, open LABELVIEW and go to Options 
menu > Configuration > Network tab. 
Check the Network Key box, and for the 
Server Location, browse to the mapped 
letter drive location of the program’s 
LICENSE directory. Click OK, and then 
restart the program. 

I do not have a Parallel or 
USB port that matches the 
hardware key that came with 
my software. What can I do?

We do not recommend or support port con-
verters for use with hardware keys. If you 
do not have the appropriate port available 
on your computer, please contact Customer 
Service at 888-629-4444 or e-mail 
customerservice@teklynx.com.

(Table continued from previous page)

Problem/Question Solution
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I have more than one 
printer, but only one hard-
ware key.

The hardware key contains the version, edi-
tion and number of licenses available. It is 
not related to the number or location of the 
printers you will be using. 

I lost the CD and I need to 
re-install the software. What 
do I do?

For Hardware Key versions, if you lost the 
CD and need to re-install, you can download 
the re-installation files from the TEKLYNX 
web site at http://www.teklynx.com/prod-
ucts//labels/labelview_downloads.html. 
Please verify that the version number 
printed on your hardware key label matches 
the version that you download. As long as 
the versions match and the key is properly 
attached, this is all that is needed to re-
install the software.

General Issues

When using LABELVIEW 
Network with a Terminal 
Service session, I get an 
error, “Microsoft Visual C++ 
Runtime Library Runtime 
error... abnormal program 
termination.”

This error is caused by a Microsoft security 
update for Windows Server 2003, Windows 
XP SP2, and Windows 2000 SP4. The secu-
rity update makes the ability to create glo-
bal objects a privileged operation. 
Instructions for resolving this issue can be 
found on the TEKLYNX web site at 
http://www.teklynx.com/products//labels/
faq/labelview/faq_1325.html.

Error 432: Setup has 
detected that InstallShield is 
in use. Please close 
InstallShield and restart 
setup

This is an InstallShield error that can occur 
for a number of reasons. For information on 
resolving this issue, go to 
http://consumer.installshield.com and 
search on “Error 432”.

How do I know that the CD I 
received contains the latest 
release of the software, 
including any recent patches 
or updates?

You can verify this by checking your soft-
ware version number against the version 
number of the LABELVIEW Demo found at 
http://www.teklynx.com. The LABELVIEW 
Demo is always updated with the most 
recently released version of the software. 
Please verify that your version matches the 
Demo version. 

(Table continued from previous page)

Problem/Question Solution
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Why are some features and 
options grayed out or not 
available?

Many of the features covered in the LABEL-
VIEW Quick Start Guide and online Help are 
available only in the mid-range (Pro) or 
high-end (Gold) editions of the software. If 
an option appears “grayed out” and is not 
available for selection, this is most likely 
because that feature is not included in the 
edition you purchased.

A complete list of features included in each 
edition can be found in the "LABELVIEW 
Editions" section on page 1-2 of this guide.

Where can I find sample 
labels, training manuals, and 
tutorials? 

Sample label design files and compliance 
label templates can be found in the pro-
gram’s Samples folder (i.e., C:\Program 
Files\LV8\Samples). You can also access 
many helpful resources directly from within 
LABELVIEW by going to the Help menu > 
Teklynx Online.

In addition, both BASIC and ADVANCED 
level training manuals (including step-by-
step tutorials) are available from TEKLYNX 
for a fee. For more information, please con-
tact TEKLYNX Customer Service.

Why should I register my 
TEKLYNX Label Design Soft-
ware?

Registering your software not only provides 
you with free Technical Support options, but 
it also ensures you are notified of critical 
updates and patches as they are released.

It is easy to register your TEKLYNX soft-
ware. See the "Registering Your Software" 
section on page 1-6 for more information.

What Technical Support is 
available? 

From within LABELVIEW go to the Help 
menu > Teklynx Online. From here you 
can quickly access many support resources 
including eHelp videos, Technical Support 
FAQs, PDF format manuals and guides, and 
more. 

For phone support, please contact your 
label design software supplier.

(Table continued from previous page)

Problem/Question Solution
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